
Connectelligence 
Version = 2017.22.713 
Release Notes 

07/14/2022 
Designer 
BUG: Fixed minor issues with visual elements. 
FEATURE: Added ‘Delete Map’ button to Deployments tab. 
FEATURE: Improvements to text filtering responsiveness on the deployments tab. 
FEATURE: When searching files on the Reports tab, files with matching search results are now opened 
with the cursor positioned on the first hit of the search. 
 
Service Maps 
FEATURE: Added support for dynamically read configurations settings under the 
MySystems.<<SystemName>> area used by service maps. 
 
Connectelligence 
Version = 2017.22.614 
Release Notes 

06/14/2022 
All 
BUG: Fixed problematic visual elements including the background on the database connection chooser 
and some dynamically-generated labels in the Transaction Manager. 
BUG: Some Big Brother settings were not being created on service deployment – Fixed. 
 
Connectelligence 
Version = 2017.22.425 
Release Notes 

04/25/2022 
All 
BUG: Fixed problematic visual elements including some grids and combo boxes. 
 
Connectelligence 
Version = 2017.22.408 
Release Notes 

04/01/2022 
All 
CHANGE: Many additional forms and elements are now in MetroDark style 
 
Transaction Manager 
BUG: Would crash at startup in environments without OneNote installed – Fixed. 
 
Connectelligence 
Version = 2017.22.9 
Release Notes 

04/01/2022 
All 
CHANGE: Updated framework to v4.8. 
 
Designer  



CHANGE: The error message “The '{InstanceName}' is currently running as an application 
on this machine.  Cannot start two instances of the same service. “ has been changed 
to a warning.  It still blocks execution, but the Error Reporting services no longer reports this as an error. 
 
All 
CHANGE: Continued changing of most visual items to dark mode. 
 
Connectelligence 
Version = 2017.22.5 
Release Notes 

02/15/2022 
Designer  
FEATURE: Deployments screen is now MetroDark style. 
BUGE: Deployments views functionality was broken – Fixed. 
 
Installer 
BUG: Initial install could hard-crash with the error “*** BEGIN ERROR” repeated over and over again in 
the log file (and no other error details) – Fixed. 
Several minor bug fixes 
 
Connectelligence 
Version = 2017.22.4 
Release Notes 

02/14/2022 
All – Removed support for multiple languages and the MLTLanguage object.  Functionality is deprecated 
and having the objects still used in places was causing errors. 
All – Removed support for user-defined data types in Sql Server for the InstanceType field and watcher 
type field.  Sql Server is deprecating UDT functionality. 
 
Connectelligence 
Version = 2017.22.3 
Release Notes 

02/01/2022 
Designer 
BUG: Opening Tools->Options->Landscape Manager would cause background errors and corrupt the 
landscape connection strings – Fixed. 
BUG: File and Table libraries could cause deployment failures with the error “Class is not marked as 
serializable” – Fixed. 
FEATURE: Added new configuration data type option: “Password”.  Masks text for purposes of hiding 
passwords. 
FEATURE: Made changes to the email configuration form to allow passwords to be entered and copied 
without being visible (such as during screen sharing). 
FEATURE: Continue incremental switch to dark theme by introducing more dark mode elements to several 
screens. 
 
Base Libraries 
Database fields in a source library that were not parse-able into a .NET base type could cause deployment 
failures. – Fixed. 
 
Built-In Services 
BUG: Built-in services would fail with object reference error – Fixed. 



BUG: Big Brother service drive space checks would fail for CD ROM drives – Fixed (they are now ignored 
by the drive space remaining check) 
 
Connectelligence 
Version = 2017.13.80 
Release Notes 

Designer 
BUG: Performing a single map promotion did not recreate the transaction definition – Fixed. 
BUG: Promoting a single map that utilized a built-in function as a source or target caused the 
BuiltInFunctions.dll file to be copied as part of the promotion (not desired) – Fixed. 
BUG: Deploying against a database using SQL security that had a character “]” or “{“ in the password 
would cause the deploy to fail due to a logging error thrown by String.Format() – Fixed. 
BUG: The TrapErrors parameter on SqlServer calls was not being properly evaluated and honored – Fixed. 
CHANGE: The current view name is now shown in the deployment screen. 
 
Connectelligence 
Version = 2017.13.79 
Release Notes 

Designer 
BUG: Deleting a map could throw an error stating that the transaction table does not exist (innocuous) – 
Fixed. 
FEATURE: Added support for filtering file and table libraries in the master data definitions. 
 
Connectelligence 
Version = 2017.13.78 
Release Notes 

Common 
BUG: Not all retriable errors for web connectivity exceptions were not being properly identified - Fixed. 
 
Connectelligence 
Version = 2017.13.75 
Release Notes 

Transaction Manager 
BUG: Monitoring service transactions in real-time could be severely slowed on some systems with 
SkipWpfDoEvents = True (workaround is to set SkipWpfDoEvents = False). - Fixed 
CHANGE: SkipWpfDoEvents now has a default value of True rather than False.  Newer systems behave 
better with this setting turned off. 
 
Big Brother/Error Reporter 
BUG: The Big Brother and Error Reporting services were reverted to an earlier build due to a DevOps bug.  
The current version is now restored. 
 
Connectelligence 
Version = 2017.13.74 
Release Notes 

Common 
FEATURE: MSMQ messaging could sometimes fail with “Access to Message Queuing system is 
denied”.  This was sporadic.  This error is now automatically retried prior to erroring. 
 
Designer 



BUG: Changing a connection string would not take effect for new deployments until a restart – Fixed. 
 
Connectelligence 
Version = 2017.13.73 
Release Notes 

Common 
FEATURE: Retriable errors in the RetriableErrors class can now be extended with user-defined errors 
placed in C:\Connectelligence\Reports\RetriableErrors.txt 
 
Connectelligence 
Version = 2017.13.72 
Release Notes 

Common 
BUG: Entity Framework – SelectByKeys() function in c# was broken – Fixed. 
BUG: Entity Framework – VARCHAR(MAX) fields were being trimmed to zero bytes – Fixed. 
BUG: Setting a value for LastRecordRetrievedAt now clears the ReprocessItem (if there is one). 
FEATURE: Added two new conditions for webservice call automated retry: “Could not create SSL/TLS 
secure channel”, “Web service processing error”. 
 
Designer 
BUG: Data map chooser grid filtering was not filtering properly for True/False/Either options. 
BUG: When deploying a map without having defined a service account, the options area for defining a 
service account was not being properly selected. 
BUG: On startup a message could appear asking to install the Built-In Services – Removed. 
FEATURE: The deployment option to auto-backup to support rollbacks now has three choices: Always, 
Never, and Automatic.  Automatic will only perform backups on production systems. 
 
Transaction Manager 
BUG: Service chooser grid filtering was not filtering properly for True/False/Either options. 
 
Connectelligence 
Version = 2017.13.71 
Release Notes 

Common 
FEATURE: Added options for user specified paths to vbc.exe and csc.exe (config file only). 
 
Connectelligence 
Version = 2017.13.66 
Release Notes 

Common 
FEATURE: New feature to transform an object into a T-SQL command. 
 
Connectelligence 
Version = 2017.13.64 
Release Notes 

Designer 
BUG: Mapping did not properly accommodate sql field type VARBINARY – Fixed. 
FEATURE: Small performance improvement to mapping screen for systems with just a few maps.  
Dramatic performance improvement for systems with a large number of maps. 
 



Connectelligence 
Version = 2017.13.63 
Release Notes 

Common 
BUG: Compiling the main library could fail if a field of type uniqueidentifier (Guid) was mapped.  This is 
due to changes in how .NET handles Guids – Fixed. 
BUG: The entity framework could fail to compile if any fields of type CHAR were encountered – Fixed. 
 
Connectelligence 
Version = 2017.13.61 
Release Notes 

Error Reporting Service 
FEATURE: Messages now contain the error id and the time the error was generated.   
 
CommonBase 
BUG: Dynamic Sql commands would fail if issued with the sql command set separately – Fixed. 
 
All 
CHANGE: Removed remaining references to VisualBasic.TriState for better compatability with C# projects. 
 
Connectelligence 
Version = 2017.13.60 
Release Notes 

Designer 
CHANGE: Services are now deployed with BigBortherTempDisable = True.  This prevents Big Brother from 
starting newly deployed maps automatically. 
 
Map - JableJoinWatcher 
FEATURE: if the key fields used to define unique records had any case differences with the actual 
database fields then errors would generate, and records would be reprocessed – indefinitely.  Now if this 
situation occurs now a warning is logged and the record processes normally. 
 
Big Brother Service 
BUG: Big Brother was not automatically resetting the ‘Big Brother Temp Disable’ flag for running services 
– Fixed. 
 
Common Library 
FEATURE: Added DumpObject() function to dump all properties of an object (Similar to ‘?’ in the Visual 
Studio immediate window) 
CHANGE: VisualBasic TriState has been replaced with an internal TriStates enumeration to avoid problems 
when creating maps in c#. 
 
Connectelligence 
Version = 2017.13.58 
Release Notes 

Designer 
BUG: Promotion of a single data map would fail under some circumstances – Fixed. 
FEATURE: Dramatically improved speed of importing packages (adapters, backups and promotions) for 
large project directories. 
FEATURE: Importing packages now saves a copy of the existing Projects folder under Projects Archives. 
FEATURE: New option to show/hide code projects on the master data definitions grid. 



 
Transaction Manager 
FEATURE: Recurring integration now has option to only process records later than right now. 
FEATURE: Minor improvements to initial load time. (Background tasks) 
 
Connectelligence 
Version = 2017.13.56 
Release Notes 

Designer 
BUG: Default adapter did not have the field 
Connectelligence2017.Connectelligence.AdapterLandscapes.IsProductionSystem.  As a result, errors 
pertaining to ‘IsProductionSystem’ could be raised – Fixed. 
BUG: Importing Connectelligence Services project could fail with a ‘Unable to copy directory’ – this was 
due to an invalid filename – Fixed. 
BUG: Configuration settings were being overwritten for all adapter imports.  The configuration should 
NOT be overwritten for promotions - Fixed. 
BUG: Importing a new adapter for the first time could generate object reference error(s) (innocuous) – 
Fixed. 
CHANGE: Downloading updates from File menu now uses HTTP rather than FTP technology. 
 
Installer 
BUG: Installer would prompt user to re-deploy the built-in libraries even if they had not changed.  User is 
now prompted to redeploy only if there is new code or configuration hat has changed – Fixed. 
 
Connectelligence 
Version = 2017.13.54 
Release Notes 

Error Reporting Service 
CHANGE/FEATURE: Errors more than one week old are now skipped for reporting (emailing) by default in 
order to prevent the service from being started for the first time in months and reporting thousands of 
errors. 
 
Designer 
BUG: When changing an existing data map to have a new source or target endpoint, errors could generate 
pertaining to the previous endpoint – Fixed. 
 
Connectelligence 
Version = 2017.13.53 
Release Notes 

Transaction Manager 
BUG: Marking a transaction for reprocessing resulted in a program crash caused by infinite recursion – 
Fixed.  
 
Connectelligence 
Version = 2017.13.52 
Release Notes 

Designer 
BUG: Importing packages could sometimes generate post-import errors (innocuous) – Fixed. 
BUG: Mass re-deploy could fail with “Unknown Instance Type” – Fixed. 
BUG: The InstanceType was not being saved with report options/map settings – Fixed. 



BUG: When editing a function library in the master data editor, choosing a code or project path did not 
always filter to the proper language being used (C# or vb) – Fixed. 
BUG: Renaming a map (with Best Practices turned on) produced a bogus Best Practice violation warning – 
Fixed. 
BUG: Deleting a map was not deleting the map’s transaction table, which caused errors during promotion 
or backup-restore – Fixed. 
BUG: Typing extremely fast into the search filter on the deployments screen would cause errors and 
sometimes a hard crash – Fixed. 
FEATURE: Right-click context menu on the configuration grid now allows you to edit connection strings. 
 
Installer 
BUG: Installer was not uninstalling applications because the uninstaller requires elevated permissions.  
The uninstall process is now launched with elevated permissions – Fixed. 
 
Connectelligence 
Version = 2017.13.51 
Release Notes 

Designer 
BUG Deployments grid was not showing vertical scroll bars when there were records that extended 
beyond the screen – Fixed. 
 
Big Brother 
CHANGE: Big Brother configuration form now warns if the Big Brother map is not deployed, but still allows 
the configuration form to remain open. 
CHANGE: Default settings changes: 
Memory max default changed from 200MB to 400MB. 
Log file records default max age changed from 90 days to 45 days. 
Log file history records default max age changed from 120 days to 90 days. 
 
Common 
BUG: When Un-deploying and deploying maps, messages were logged regarding a corrupted map – Fixed. 
 
Connectelligence 
Version = 2017.13.50 
Release Notes 

Designer 
BUG: The ‘Default View’ for deployments was not being properly created on new environments – Fixed. 
BUG: Deploying services would not work properly on environments where the MyDocuments folder was 
mapped to a network drive or to Microsoft OneDrive – Fixed, 
FEATURE: Deployment packages that fail to compile now offer a “Retry” option to allow the problem to be 
manually corrected and retried. 
BUG/FEATURE: Visual Studio 2019 broke current functionality by making a change to the default build 
location (adding framework or core version to the path).  This is now corrected by automatic injection of 
AppendTargetFrameworkToOutputPath = “False” into the project file once it is created. 
FEATURE: Improved speed of un-deploying services. 
 
Installer 
BUG: Default adapter was not including the Connectelligence Services project – Fixed. 
BUG: Default adapter was not rebranding properly for non-Connectelligence brands – Fixed. 
FEATURE: Installer now traps for situations where it is unable to create the deployment directory due to 
windows access rights.  The user is prompted to manually create the required directory. 



FEATURE: Built-in services (Big Brother, Error Reporter, and Scheduler) are now copied after the main 
installation (user is prompted to overwrite if this is an update rather than a fresh install). 
 
Connectelligence 
Version = 2017.13.49 
Release Notes 

Designer 
BUG: drop down combo boxes were not appearing for enumeration values in grids – Fixed. 
 
Connectelligence 
Version = 2017.13.48 
Release Notes 

Designer 
BUG: Display issues when navigating to data maps tab or opening the data map chooser from the data 
maps tab – Fixed. 
 
Big Brother 
FEATURE: Big Brother service now monitors for database space where the remaining space in the 
database file is less than the auto-grow setting (indicating that an overrun of db space is imminent). 
 
Connectelligence 
Version = 2017.13.45 
Release Notes 

Designer 
BUG: Data maps would fail to automatically map records (bug introduced in .43) – Fixed. 
 
Connectelligence 
Version = 2017.13.44 
Release Notes 

Base 
FEATURE: Added General Network error and Transport-level error to the list of automatically retriable sql 
command execution errors. 
 
Connectelligence 
Version = 2017.13.43 
Release Notes 

Designer 
FEATURE: Added Quick-search to the top of the data map chooser. 
FEATURE/CHANGE: Design/Layout changes to data map chooser. 
FEATURE/CHANGE: Choosing to rebuild in the master data editor now automatically chooses the current 
record (if on tab 3) or automatically chooses the entire library (if on any other tab). 
 
Connectelligence 
Version = 2017.13.42 
Release Notes 

Designer 
BUG: Rebuilding a library that added/removed data map records did not reflect the changes on the data 
map tab – Fixed. 
BUG: Creating a new data map was broken (bug from previous version) – Fixed. 



CHANGE/FEATURE: Master data editor now rebuilds just the current library if one is selected and user Is 
on the third tab.  If user is on any other tab then all libraries are rebuilt. 
 
Connectelligence 
Version = 2017.13.41 
Release Notes 

Designer 
CHANGE/FEATURE: Dramatic redesign of deployment screens. All deployment screens are now WPF and 
include options for filtering by rows and columns for every conceivable combination. 
CHANGE/FEATURE:Data map grid is now WPF (previously Winforms) 
 
Connectelligence 
Version = 2017.13.37 
Release Notes 

Base 
CHANGE/FEATURE: RetriableErrorClass now has separate methods for RetryByDelegate, RetryByOverride, 
RetryByEvent, and Retry<T>(IQueryable<T> Args). 
BUG/FEATURE: Numerous small improvements and minor bug fixes to RetriableErrorClass. 
 
Connectelligence 
Version = 2017.13.35 
Release Notes 

Designer 
BUG: When changing the password in the Designer, the new password was not applied to existing 
deployments until the second re-deployment attempt.  The logic now tests the old password and uses it if 
it is valid and discards it for the new password if it is not valid. 
BUG: Built-in services would sometimes fail to compile when redeployed (but would compile fine in Visual 
Studio) due to an invalid StartupObject passed to DevEnv.exe – Fixed. 
 
Transaction Manager 
FEATURE: Configuration table editor now support mass changes to any value.  Updates are made to all 
deployed services. 
 
Connectelligence 
Version = 2017.13.33 
Release Notes 

Designer 
FEATURE: When deploying a map, if the Visual Studio templates are missing they are now automatically 
copied at the time of deployment (for the language of the project deployed). 
FEATURE: When choosing to script and entire database in the entity framework, you are now prompted to 
include Tables, Views, Synonyms. 
FEATURE: Data grid choices now support captions. 
 
Connectelligence 
Version = 2017.13.32 
Release Notes 

Designer 
FEATURE: Transaction tables (From the Transactions schema) are now included with all package 
export/imports. 



FEATURE: Entity framework now supports a new option: “Script entire database”.  If read-only then all 
files are created automatically.  If read/write then user is prompted for keys on each table. 
 
Connectelligence 
Version = 2017.13.31 
Release Notes 

Designer 
BUG: The configuration grid could get “jumpy” and appear to move around under certain conditions – 
Fixed. 
BUG: Importing an adapter was broken– Fixed. 
FEATURE/CHANGE: Exporting an adapter/backup/promotion now skips zip files in the projects directory. 
 
Connectelligence 
Version = 2017.13.30 
Release Notes 

Designer 
BUG: Re-Deploying a service map, if the map was running during deployment it was not always restarted 
automatically after re-deployment – Fixed. 
BUG: Re-Deploying a service map could cause problems due to multiple compilations of the deployed 
project (one for deployment, and one after) – Fixed. 
FEATURE: Speed improvement when Re-Deploying a service map due to omission of redundant file 
copies. 
CHANGE: User is no longer prompted if the main library is current and a recompile is attempted.  This 
prompt proved to be more disruptive than just performing the recompile. 
CHANGE: Rebranding of imported adapters is now limited to just the default adapter (by default.  The 
default can be overridden in the UI) 
 
Transaction Manager 
BUG: When a service failed to start due to a logon failure, the error message was not being logged – 
Fixed. 
 
Base 
FEATURE: Recurring Integration class now has three different methods supported for automated error-
retry looping: By event, by delegate, and by override method.  
 
Connectelligence 
Version = 2017.13.24 
Release Notes 

Services 
BUG: Fixed typo for Missing Link Technology that appeared in service registrations. 
 
Base 
FEATURE: Recurring Integration class now have a retry mechanism using the web service retry sequence 
 
Connectelligence 
Version = 2017.13.23 
Release Notes 

Designer 
CHANGE: Email form was not hiding the password – Fixed. 
CHANGE: Master data editor no longer prompts for library to rebuild if there are changes in the current 
library. 



 
Connectelligence 
Version = 2017.13.21 
Release Notes 

All 
FEATURE: Recurring integration base class has new members to more easily support resetting the last 
query time: LastQueryAttemptTime, SetLastQuery from just one line of code in the user library. 
  
Transaction Manager 
FEATURE: Transactions Bar – Reprocess Previous button now supports Recurring integrations. 
FEATURE: Recurring Integration now has sub menus for Reprocess Previous, Reprocess Previous (Quick), 
Reprocess up to this row, F5 to refresh the grid, and more. 
 
Connectelligence 
Version = 2017.13.19 
Release Notes 

All 
FEATURE: Changes to accommodate AzureDB connections (increased timeouts, changes to exclude 
database commands not legal with Azure DB. 
 
Services 
FEATURE/CHANGE: Services are now prevented from starting if a debug instance of the service is running.  
This avoids the possibility of two copies of the same service running concurrently (and duplicating 
transactions). 
 
Transaction Manager 
FEATURE: Mass Action service start command now starts services asynchronously, making for 
dramatically faster start times for service groups. 
 
Connectelligence 
Version = 2017.13.18 
Release Notes 

Transaction Manager 
BUG: Service rollback could fail if current files were already deployed – Fixed. 
FEATURE: Added new config file setting for: WarnWhenOverwritingDeployedServiceFiles.  By default, 
this value is False.  When false it prevents the Transaction Manager from prompting each time a deployed 
service file has been debugged prior to overwriting the deployed files. 
FEATURE: The ServiceActionTransaction table now includes an application name and is now automatically 
populated with service: Start, Stop, Overwrite, Deploy, Undeploy, backup, and rollback. 
 
Templates 
BUG: SNicLINK template had an improper casing causing deployed services to fail to compile – Fixed. 
 
Connectelligence 
Version = 2017.13.17 
Release Notes 

Designer 
BUG: Added accommodation for importing packages that are missing some column definitions (supports 
importing of older adapters). 
BUG: Deployed service roll-back support was being bypassed if the service executable files were manually 
compiled – Fixed. 



FEATURE: Added context menu items for Deploy and Re-deploy to deployment grids. 
FEATURE: Added separate button for Re-deploy to the top of the Deployment Ribbon. 
FEATURE: Deployments that fail due to insufficient rights or invalid credentials now provide more 
information in both the error message and the log file leading up to the error message. 
FEATURE: If the MSMQ service is stopped then it is now automatically restarted during any attempt to 
send messages on the queue. 
CHANGE: BackupPriorToInstallingUpdates option is not set to Fale by default.  A new field in the 
landscapes table has been added: IsProductionSystem.  This is used to automatically set automatic 
backups on production systems. 
CHANGE: Rollback copy now takes place prior to deployment of new files. 
 
Transaction Manager 
FEATURE: Recurring integration form now has a context menu to delete records, groups, or view details as 
well as support for the Delete key. 
 
Connectelligence 
Version = 2017.13.16 
Release Notes 

Internal build 
 
Connectelligence 
Version = 2017.13.15 
Release Notes 

Designer 
BUG: Importing a package could choose the incorrect package if more than one package exists in the 
import directory – Fixed, 
FEATURE: New option to export all projects in projects directory (not just those registered with 
Connectelligence). 
 
Connectelligence 
Version = 2017.13.14 
Release Notes 

Big Brother 
FEATURE: Big Brother now purges old log files and records only once per day.  It also increases the 
command timeout to 30 minutes prior to each database purge operation to allow for the extra time 
needed to purge tables with millions of rows. 
 
Connectelligence 
Version = 2017.13.13 
Release Notes 

All 
FEATURE:Added support for new MSBuild location (in Program Files(x86)) with Visual Studio 2019 
installations. 
 
Connectelligence 
Version = 2017.13.11 
Release Notes 

All 
FEATURE:Added support for .NET v4.8 
 



Connectelligence 
Version = 2017.13.10 
Release Notes 

Designer 
FEATURE: Fewer errors if working with a blank system.  Loading at least some data is still recommended 
but working with a blank system is now usable and with fewer error messages. 
FEATURE: Changes to support using a SAAS Sql database. 
CHANGE: Changes to the default adapter. 
 
Connectelligence 
Version = 2017.13.8 
Release Notes 

Common  
Default code language changed to c#. 
Default .NET version changed to 4.7.2 
FEATURE: Completed Installer support for Visual Studio 2019. 
 
Connectelligence 
Version = 2017.13.5 
Release Notes 

Common  
FEATURE: Updated Sql Server Management Objects (SMO) to v150.18131.0. 
 
Connectelligence 
Version = 2017.13.4 
Release Notes 

Transaction Manager 
FEATURE: Service Start/Stop actions are now logged to a table, including the username, and are available 
from Reports-All->Service Actions menu.. 
 
Connectelligence 
Version = 2017.13.3 
Release Notes 

Transaction Manager 
FEATURE: Added support for Recurring Transaction Details and choosing an item to reprocess from a list 
of already processed items. 
 
Connectelligence 
Version = 2017.13.1 
Release Notes 

General 
BUG: DefaultAdapter had a minor bug in the Connectelligence Services project that caused it to fail to 
compile – Fixed. 
BUG: Fixed a bug that caused main library compilation to fail if there were custom database types defined 
in table libraries. 
FEATURE: File/Directory copy errors containing details packaged in the Exception.Data property 
previously had the details hidden.  Now data details are packaged as part of the message body. 
FEATURE: Message box Show() called from a service now logs the error rather than a worthless message 
stating that MTA threads cannot call message boxes (when called from an MTA thread). 
 



Designer 
BUG: Importing an adapter now immediately performs a database conversion/upgrade rather than 
waiting until the next restart. 
BUG: Entity framework was not allowing the selection of the identity column as a table key field – Fixed. 
BUG/FEATURE: When a running service is redeployed, it sometimes fails to restart on the first attempt 
and a manual second attempt is required.  This second attempt is now automated after any service fails to 
enter the StartPending state within 1.5 seconds. 
FEATURE: Complete overhaul of the backup-restore and all package handling.  Code base decreased by 
80% at speed of package export and import increased by an order of magnitude. 
FEATURE: Exporting/backing-up now exports all project references (dll files) for each project library.  This 
feature plugs a huge hole in functionality that was blocking the seamless portability of adapters between 
different systems. 
FEATURE: Landscapes are now included in Export/Import operations. 
 
Transaction Manager 
BUG: If a service failed to enter a StartPending state within 1.5 seconds after the start request, the 
remediating code to restart the service was not being invoked. – Fixed. 
FEATURE: Recurring Integration form now supports reprocess items.  Allowing users to specify a reprocess 
item (BOM, product, route, etc.) to be reprocessed by a recurring integration. 
 
Big Brother 
FEATURE/CHANGE: Big Brother service now ignores the Agent service if there are no defined service 
schedules. 
 
Connectelligence 
Version = 2017.12.128 
Release Notes 

Designer 
BUG: Exporting/Backing up was not backing up some projects if LOCK files were found (If Visual Studio 
was open and locking the project) - Fixed. 
BUG: Exporting/Backing up was not backing up some projects containing subfolders - Fixed. 
BUG: When creating a new database, some innocuous errors would be logged - Fixed. 
FEATURE: Dramatic speed improvement to Import screen when loading many packages. 
FEATURE: Added option to load default adapter with verbose logging. 
 
Connectelligence 
Version = 2017.12.125 
Release Notes 

General 
BUG: Updates for branding issues affecting web service methods not related to core functionality. 
 
Designer 
BUG: If the application configuration file was corrupt or misconfigured then backup and adapter packages 
would not load – Fixed. 
CHANGE: Recompile All feature now recompiles table and file libraries before compiling the main library.  
This is to ensure that the table and file library files exists prior to compiling the main library. 
 
Transaction Manager 
FEATURE: Timers now have a Trigger Now button available above the monitoring grid. 
FEATURE: If a service fails to progress to status=StartPending after 1.5 seconds, another service start is 
attempted automatically. 
 



Connectelligence 
Version = 2017.12.121 
Release Notes 

Designer 
BUG: A corrupted config file could make performing many actions error-prone – Fixed. 
BUG: Support Case upload would fail to contact FTP site for upload and fail to send support email – Fixed. 
CHANGE: Global – use of the Windows connection string builder has been deprecated in favor of the 
custom connection builder due to unstableness in the windows connection string builder. 
 
Default Adapter 
BUG: The default adapter, used on some initial installations, referenced 2016 information – Fixed. 
CHANGE: The default adapter now includes Connectelligence Services (for Big Brother, Error Reporting, 
and Agent services). 
FEATURE: Importing the default adapter or ANY adapter now rebrands the files to match the current 
brand when importing.   
 
Connectelligence 
Version = 2017.12.112 
Release Notes 

Services 
FEATURE: Improved startup time for startup section accessing/copying configuration settings from files.  
Saves approximately 1-2 seconds from service startup time. 
FEATURE: Big Brother service has significantly faster initial load time due to configuration file speed 
improvement. 
 
Connectelligence 
Version = 2017.12.111 
Release Notes 

Transaction Manager 
FEATURE: When a service is started or stopped through the TM, the TM now logs a message to the log file 
of the service. 
 
Connectelligence 
Version = 2017.12.110 
Release Notes 

All 
CHANGE: When logging connection strings (to a file or a record) the password is now hidden. 
 
Designer 
BUG: Some website links were broken – Fixed. 
BUG: When deploying a service and adding dependencies, a message could come back saying that a 
restart of the dependency service is required even if it is not – Fixed. 
 
Connectelligence 
Version = 2017.12.109 
Release Notes 

Transaction Manager 
FEAUTRE: Added support for including the service status as a search term.  Allows creation of views for all 
running services or all stopped services. 
FEATURE: Two new built-in views are now created automatically.  Running Services, Stopped Services. 



 
Recurring Integrations 
FEATURE: Recurring integration form has many UI changes and a new Refresh button. 
FEATURE: Recurring integration class now deletes Records=0 records each time a new record is entered 
with a non-zero Records value. 
 
Bib Brother 
FEATURE: The Big Brother service now has support for being restarted when no database connection is 
available.  If this happens, it will go into a waiting state and resume when the database becomes available.  
(New template required for existing installations). 
 
Connectelligence 
Version = 2017.12.108 
Release Notes 

Common 
FEAUTRE: Added support for Netsuite time formatting in RecurringIntegration class. 
CHANGE: ArchiveFile class now does not compress files by default.  Change was made because searching 
hundreds or thousands of compressed files is difficult so by default the searching is now easier. 
 
Designer 
FEATURE: Optimizations to master data editor to minimize main library recompilations. 
 
Connectelligence 
Version = 2017.12.107 
Release Notes 

Designer 
BUG: After adding or deleting fields from a view the main library was not being automatically recompiled 
to reflect the changes – Fixed. 
 
Connectelligence 
Version = 2017.12.106 
Release Notes 

Designer 
BUG: Help website features were not navigating to the proper web pages – Fixed. 
FEATURE: Added Dependencies functionality to Deployment/ApplyMap deployment screen. 
 
Connectelligence 
Version = 2017.12.100 
Release Notes 

Designer 
FEATURE: When hovering over a connection record in the configurations grid, the resolved configuration 
is now displayed in the grid header. 
FEATURE: Numerous small improvements to the Recurring Integrations form. 
 
Connectelligence 
Version = 2017.12.99 
Release Notes 

Common 
FEATURE: Web service timeout failover sequence added. 
 



Designer, Transaction Manager 
FEATURE: Enhanced Support for Recurring integration added.  (Timed web service queries) in Tools-
>Service Support->Recurring Integration. 
 
Connectelligence 
Version = 2017.12.98 
Release Notes 

Licensing 
BUG: Remote license updates would fail because of changes to missinglinktechnolgoy.com.  Licensing 
requests are now directed to mlceai.com – Fixed. 
 
Designer, Transaction Manager 
FEATURE: Support for Recurring integration added.  (Timed web service queries) in Tools->Service 
Support->Recurring Integration. 
 
Common 
FEATURE: Support for Recurring integration added.  (Timed web service queries) 
 
Connectelligence 
Version = 2017.12.97 
Release Notes 

Internal Releases 
 
Connectelligence 
Version = 2017.12.95 
Release Notes 

Big Brother Service 
FEATURE: Automatically increase command timeouts to handle long-running database maintenance tasks. 
CHANGE: Database maintenance tasks are now run only once daily instead of every Big Brother run. 
 
Services 
BUG: License deserialization could fail due to an incorrect xml format – Fixed. 
 
Connectelligence 
Version = 2017.12.94 
Release Notes 

All 
FEATURE: Added support for .NET 4.7, 4.7.2, 4.7.2 
FEATURE: Added support for Visual Studio 2019 
CHANGE: All instance arrays are now case-insensitive, eliminating some problems on branded systems 
where the brand name case appears differently in different places (Such as the Big Brother Service). 
 
Designer 
CHANGE: Removed beta warning from Entity Framework. 
 
Big Brother Service 
CHANGE: Table record purging is now limited to once per day to avoid strain on the database. 
CHANGE: Default settings for record and file purging now suppress email notification. 
 
Connectelligence 
Version = 2017.12.93 



Release Notes 

Built-in services 
CHANGE: Updated to .NET v4.6.1 
 
Designer 
CHANGE: Changes to licensing web access. 
 
Connectelligence 
Version = 2017.12.92 
Release Notes 

Transaction Manager 
BUG: Using shift-click to forcibly stop a service was not working – Fixed. 
BUG: Could get object reference error on startup due to old unprocessed MSMQ messages – Fixed. 
 
Designer 
BUG: Creating a new C# function would fail to compile due to Catch statement casing – Fixed. 
 
Error Reporting Service 
FEATURE: Service now groups errors into a single email per run. 
 
Agent Service 
BUG: Agent service would not respond to stop command – Fixed. 
 
Connectelligence 
Version = 2017.12.91 
Release Notes 

Apps 
BUG: Creating an up-time schedule would not save the record due to a NOT NULL field restriction – Fixed. 
FEATURE: Down-time schedules now restart services after the end of the scheduled down time. 
 
Common 
CHANGE: Integration errors now skip automatic logging by default (unless a true parameter is passed to 
the constructor) to avoid problems on some systems where no logging takes place and Logged = True. 
 
Connectelligence 
Version = 2017.12.90 
Release Notes 

RunSubset 
BUG: If criteria resulted in no records being selected and object reference error was thrown – Fixed. 
 
Connectelligence 
Version = 2017.12.89 
Release Notes 

Transaction Manager 
BUG: Deploying a map in the Designer did not cause the newly deployed map to appear in the Transaction 
Manager without a manual refresh – Fixed. 
 
Connectelligence 
Version = 2017.12.88 
Release Notes 



Designer 
BUG: Deleting a library element would cause an object reference error (element was deleted, but still 
visible) – Fixed. 
FEATURE: Consistency Report now removes any invalid map records that are missing key data (minor 
corruption leading to unusable map records). 
 
Common 
BUG: ParmsToText() method was not properly logging sql parameters so that they could be pasted into 
SQL Server management studio – Fixed. 
 
Connectelligence 
Version = 2017.12.87 
Release Notes 

INTERNAL 
 
Connectelligence 
Version = 2017.12.86 
Release Notes 

Modules 
BUG: Big Brother configuration was not properly loading all settings related to file/record purging – Fixed. 
FEATURE: Minor corruption of map or master records where the group or map name is null or empty is 
now tolerated during the main library compilation. 
CHANGE: View Log file path is now quoted when calling the default log file view to prevent problems with 
some viewers. 
 
Common 
FEATURE: Better logging of errors when running stored procedures. 
 
Connectelligence 
Version = 2017.12.85 
Release Notes 

Services 
BUG: A warning was being logged on service startup stating that the Transaction Manager queue does not 
exist – Fixed. 
 
Designer: 
BUG: When redeploying a map to a running service, the service was not always restarted after the 
redeployment – Fixed. 
 
Connectelligence 
Version = 2017.12.84 
Release Notes 

Applications 
BUG: File->View Log was not working for some text editors that expected a quoted string – Fixed. 
 
Transaction Manager: 
FEATURE: A timer with a countdown is now available in the real-time monitor at the top of the grid.  This 
provides a countdown to the next timer trigger. 
 
Connectelligence 
Version = 2017.12.83 



Release Notes 

Core 
CHANGE: Removed oData objects from install to avoid conflicts with user objects. 
FEATURE: New option to log Event Triggers.  Option stored in service master data. 
 
Connectelligence 
Version = 2017.12.82 
Release Notes 

Installer 
CHANGE: .NET version update dialog suppressed if no updates were made. 
 
Base Services 
CHANGE: CMap changes are no longer logged after the first change (for running services) 
 
Connectelligence 
Version = 2017.12.81 
Release Notes 

Transaction Manager 
FEATURE: Visual Studio access (debugging) is now limited to only users in the developer security group 
(same rights as the Designer). 
 
Connectelligence 
Version = 2017.12.80 
Release Notes 

Designer 
BUG: Best practice violation could occur when renaming maps – Fixed. 
FEATURE: Visual Studio can lock files and cause file copy/overwrite operations to fail.  A warning is now 
displayed if Visual Studio is running during a backup attempt. 
CHANGE: Map names are now enforced to be legal names (No spaces or other characters not suitable for 
use in .NET functions). 
CHANGE: DataType field in systems and system maps is now displayed always, instead of only when 
“Show Advanced” is checked. 
 
Common Libraries 
CHANGE: Logging of “Using Cmap file …” and “Using options from …” is now limited to just the initial time 
the map processes data in order to minimize log messages. 
CHANGE: Removed oData references in order to avoid potential conflicts with oData versions in maps 
(user code). 
 
Connectelligence 
Version = 2017.12.79 
Release Notes 

Designer 
FEATURE: Added support for .NET v4.7.1, 4.7.2 
FEATURE: NET versions in projects and deployed maps (Source Files) are now updated on install to the 
minimum .NET version. 
CHANGE: Minimum .NET version support is now 4.6.1 
CHANGE: Minimum Visual Studio version support is now v2015. 
 
Connectelligence 



Version = 2017.12.78 
Release Notes 

INTERNAL RELEASE 
 
Connectelligence 
Version = 2017.12.77 
Release Notes 

Designer 
BUG: Big Brother Management form would sometimes crash on startup due to a race condition – Fixed. 
 
All 
BUG: Errors logged with the method MLTTrace.Log(MessageTypes.Error) were not being logged to the 
T_ErrorTransaction table, thereby skipping email notification – Fixed. 
 
Connectelligence 
Version = 2017.12.76 
Release Notes 

INTERNAL RELEASE 
 
Connectelligence 
Version = 2017.12.75 
Release Notes 

Modules 
BUG: FTP operations would fail with “Method not found” – Fixed. 
 
Designer 
CHANGE: Deployment tab now has ‘Advanced’ options shown by default. 
 
Connectelligence 
Version = 2017.12.74 
Release Notes 

All 
FEATURE: All libraries and modules updated to .NET v4.6.1 
 
Common Library 
BUG: Errors were being logged to the transaction log file twice (no matter what exception type) – Fixed. 
 
Adapters 
FEATURE: Added SNic Adapter 
FEATURE Added d365 Adapter 
 
Connectelligence 
Version = 2017.12.73 
Release Notes 

INTERNAL RELEASE. 
 
Connectelligence 
Version = 2017.12.72 
Release Notes 



Entity Framework (Still in beta) 
BUG: Minor bug fixes. 
 
Connectelligence 
Version = 2017.12.72 
Release Notes 

Entity Framework (Still in beta) 
BUG: Key field types of type Guid caused compilation errors – Fixed. 
 
Designer 
BUG: The Big Brother management form could crash on load (sporadic) – Fixed. 
 
Connectelligence 
Version = 2017.12.71 
Release Notes 

Entity Framework (Still in beta) 
BUG: Bug Fixes. 
FEATURE: Added support for creating a class based on the current view in the mater data editor. 
FEATURE: Read-only classes now have the same properties and methods and read-write except those that 
actually update/delete/insert data. 
 
Connectelligence 
Version = 2017.12.70 
Release Notes 

(INTERIM BUILD – Internal use only) 
Entity Framework (Still in beta) 
FEATURE: Added support Select (single record based on field populated values) from generated class. 
CHANGE: Refactoring of generated classes to make all tables compile to a single class with SELECT 
accessors as a part of that class. 
 
Designer 
BUG: Maps created under a previous version that were deployed on a later version that had new cmap 
settings would cause errors during deployment and Big Brother monitoring.  All cmap development files 
are now upgraded automatically with each version upgrade. 
 
Connectelligence 
Version = 2017.12.69 
Release Notes 

Entity Framework (Still in beta) 
BUG: Minor bug fixes. 
FEATURE: Added support for multi-keyed tables. 
FEATURE: Added support for multiple table definitions (in clipboard) used to make multiple class 
definitions in a single operation. 
 
Connectelligence 
Version = 2017.12.68 
Release Notes 

Entity Framework (Still in beta) 
BUG: Minor bug fixes. 



FEATURE: Implementation class now supports predicate (of T) – VB and <T> - C#.  This allows for more 
generic calling of any EF class from a single source. 
FEATURE: Implementation class now includes methods to get a single record or many records and convert 
the results into class object(s). 
FEATURE: Implementation class now supports an inherited database connection (from the current 
system) and shared/static calls to get records, meaning records can now be access with just one line of 
user code. 
FEATURE: Added interfaces to support generic calls (Of T), <T>. and calls of type object (VB) or dynamic 
(C#). 
FEATURE: Added interface mimicking all fields in the table. 
 
Connectelligence 
Version = 2017.12.67 
Release Notes 

Entity Framework (Still in beta) 
BUG: Minor bug fixes. 
FEATURE: New static class allows for InsertOrUpdate() with no constructors. 
FEATURE: Support added for parsing a multiple CREATE TABLE commands from the clipboard.  This can 
save hours in situations where many tables (or even the entire database) needs entity framework 
support. 
 
Connectelligence 
Version = 2017.12.66 
Release Notes 

Designer 
BUG: Renaming a system map would not rename the master record, causing minor data corruption – 
Fixed. 
FEATURE: Added new object MyDatabases to main compile.  All databases defined in the Current System 
Configurations are now available here (as well as the usual spot in MySystems). 
 
Entity Framework (Still in beta) 
BUG: Minor bug fixes to entity framework. 
 
Connectelligence 
Version = 2017.12.65 
Release Notes 

Designer 
BUG: Various bug fixes to entity framework. 
BUG: Various bug fixes to C# code injection. 
FEATURE: Entity framework now automatically sets the database connection when constructed according 
to the current landscape. 
 
Connectelligence 
Version = 2017.12.64 
Release Notes 

Designer 
BUG: When creating a new database, the MAINTAIN stored procedure could fail with an error if the new 
database had a space in the name – Fixed. 
BUG: Object reference error could appear when opening the endpoint map chooser if no function 
endpoints were defined and mapped – Fixed. 



BUG: Object reference error could appear when creating a new system map record under certain 
conditions – Fixed. 
BUG: C# code injection was not inserting the Args.Log(ex); command properly in the catch block – Fixed. 
BUG: C# code injection could duplicate the Args.Log(ex); command under certain conditions – Fixed. 
BUG: Batch deployments were not being honored under certain conditions– Fixed. 
FEATURE: A detailed warning is now given if attempting to create a new table library without first 
assigning connection strings to a configuration. 
CHANGE: Feature to ‘Warn if user is not an administrator’ is deprecated 
 
Transaction Manager 
BUG: Object reference errors could occur on startup under certain conditions – Fixed. 
BUG: Fixed bug when creating TCPIP Watcher 
 
Templates 
BUG: C# templates had errors in the Assembly.info files – Fixed. 
 
Entity Framework 
BUG: Various minor bug fixes. 
 
Reporting Screen 
FEATURE: Updated look and feel.   
 
Connectelligence 
Version = 2017.12.63 
Release Notes 

Designer 
FEATURE: Added support for d365 system configuration-adapter. 
FEATURE: Added support for WithoutWire system configuration-adapter. 
 
Connectelligence 
Version = 2017.12.62 
Release Notes 

Designer 
BUG: When choosing an endpoint in the data map creator (header), an object reference error could occur 
(sporadic) – Fixed. 
FEATURE: Added feature to skip blank (corrupted) records when recompiling the main library in order to 
tolerate mild database corruption where there are blank endpoint records. 
 
Connectelligence 
Version = 2017.12.61 
Release Notes 

Designer 
FEATURE: Added additional logging and error traps for deployments for more human readable errors 
regarding Visual Studio templates. 
BUG: Fixed error in view definition [Connectelligence].[v_DataMapHeader] that was causing sql 
database update errors. 
 
Connectelligence 
Version = 2017.12.60 
Release Notes 

Designer 



BUG: Due to firewall changes on MLT servers, existing FTP calls (using passive mode) no longer work.  
Changes made to the application (to convert to active mode) to support file transfers for: 
 Upload->Support Cases 
 Upload->Backups (on shift-backup) 
 Download->Release Notes 
 Download->Latest Version 
 
Connectelligence 
Version = 2017.12.59 
Release Notes 

Big Brother 
BUG: Service would hang when monitoring time watcher maps that were configured to wait for a file to 
appear prior to triggering – Fixed. 
 
Transaction Manager 
BUG: If a service failed to stop and entered the StopPending state, the stop button in the UI was disabled, 
preventing the user from using a SHIFT-Stop to forcibly stop the service – Fixed. 
 
Connectelligence 
Version = 2017.12.58 
Release Notes 

Designer 
BUG: Bug fixes to C# code injection. 
BUG: Bug fixes to C# Entity Framework code generation. 
FEATURE: Entity Framework, added support for truncating strings to meet database string length 
constraints. 
 
Connectelligence 
Version = 2017.12.57 
Release Notes 

Designer 
BUG: Bug fixes to Entity framework class for both vb.net and c# code. 
 
Templates 
BUG: Projects deployed as optimized C# projects would fail to compile because the target method 
constructor used New rather than new keyword (casing) – Fixed. 
BUG: Csharp template had assembly information with invalid versions, which could lead to failure of 
services to start (for major version differences) – Fixed. 
BUG: CSharp Time Watcher Map template was corrupted – Fixed. 
 
Connectelligence 
Version = 2017.12.56 
Release Notes 

Designer 
BUG: Entity Framework did not support custom database types – Fixed. 
BUG: Save&Close for a connection on the master data editor produced a compilation error (innocuous) – 
Fixed. 
FEATURE: Transaction map creation/updating now automatically creates any custom data types that are 
present in the source table/view, but are not defined in the Connectelligence database. 
FEATURE: Entity Framework now supports class generation from synonyms and views (in addition to 
tables). 



 
Connectelligence 
Version = 2017.12.55 
Release Notes 

Designer 
BUG: Rebuild button in the master data editor caused problems for functions and is now hidden for 
libraries of type “Function”. 
FEATURE: A new ‘Entity Framework’ button is available in the master data editor for table libraries.  It 
generates class library code for accessing tables (INSERT/UPDATE/DELETE). 
 
Connectelligence 
Version = 2017.12.54 
Release Notes 

Services 
BUG: Services would stop whenever a stop command was issued, regardless of whether or not they were 
set to wait for transactions to complete prior to stopping – Fixed. 
BUG/FEATURE: Argument logging (Args.Log()) is now supported for non-optimized maps and for 
interactive debugging operations. 
 
Designer 
FEATURE: MSMQ loading and initializing optimizations. 
 
Transaction Manager 
FEATURE: Report to ‘Create Missing Indexes’ added.  (Previously there was a report to show the missing 
indexes.  Now those indexes can be created automatically). 
FEATURE: Added a master report that shows all data maintenance reports as separate tabbed reports 
within a single report windows. 
CHANGE: Changed the organization of the Database maintenance reports menu hierarchy. 
 
Base 
BUG/FEATURE: DisplayNumber() method only supported Int32 values, meaning values larger than that 
displayed as 0 bytes (visible in many reports).  Added support added for Int64 values. 
 
Connectelligence 
Version = 2017.12.52 
Release Notes 

Designer 
FEATURE: MSMQ functionality now loads all service queues in the background on startup.  This avoids a 
delay (possibly lengthy, if there are many deployed maps) the first time MSMQ is used. 
 
Services 
BUG: The ExecuteWithRetry methods could fail to pass parameters into retry executions – Fixed. 
 
Connectelligence 
Version = 2017.12.50 
Release Notes 

Designer 
BUG: Errors during background compilation could fail to show or log because of threading STU vs. MTU 
issues – Fixed. 
FEATURE: More granular error reporting for main library compilation errors. 
 



Transaction Manager 
BUG: Service Timers report only worked if the Connectelligence database was named 
Connecelligence2017 – Fixed. 
 
Connectelligence 
Version = 2017.12.49 
Release Notes 

Services 
BUG: Minor bug fixes. 
 
Transaction Manager 
BUG: Newly deployed services did not show automatically.  Now the grid is automatically refreshed if 
newly created services are not showing. 
BUG: Service status text would not always update when service status changed from Stopped<->Running 
– Fixed. 
 
Archive Class 
FEATURE: New file archive features. 
 
Connectelligence 
Version = 2017.12.48 
Release Notes 

Services 
BUG: Calls to the IsServiceCaughtUp() method to check the status of services (other than the 
currently running service) would cause the currently running service to assume the name of the service 
being checked, resulting in failed transactions – Fixed. 
 
Connectelligence 
Version = 2017.12.47 
Release Notes 

Services 
BUG: Time-based services would refuse to start if the new DirectoryToWatch or FileToWatch were not 
being used (Due to incorrectly being set as required in the database) – Fixed. 
 
Designer 
BUG: Object reference error when saving changes to a connection (innocuous) – Fixed. 
FEATURE: Added support for spaces in database name (for main configuration database) 
FEATURE: New feature in Master data editor to ‘Get database object definition’ – generates a sql script to 
recreate any database object. 
 
Connectelligence 
Version = 2017.12.46 
Release Notes 

Designer 
FEATURE: Added support for Sql query hints during deployment.  This very advanced feature can make 
the difference between executing taking minutes or taking seconds in some cases. 
FEATURE: Added a database connection string resolution button to the master data editor, in line with 
the database specification of table libraries. 
 
Transaction Manager 
FEATURE: Added zoom-in, zoom-out buttons to zoom ribbon. 



 
Connectelligence 
Version = 2017.12.44 
Release Notes 

Designer 
BUG: Scripting views (during backup or promotion operations) could fail with an error “The located 
assembly's manifest definition does not match the assembly reference”  - Fixed. 
 
Transaction Manager 
BUG: An error on startup could cause the services to fail to load, requiring a manual refresh – Fixed. 
 
Connectelligence 
Version = 2017.12.43 
Release Notes 

All 
BUG: MSMQ permissions were not being set on newer operating systems due to changes made by 
Microsoft to tighten security.  This prevented proper communications between modules and services and 
created erratic behavior on deploy/un-deploy – Fixed. 
 
Service Maps 
BUG: Logging could fail for null source values of type datetime – Fixed. 
 
Connectelligence 
Version = 2017.12.42 
Release Notes 

Designer 
BUG: When re-deploying a map, the Incremental Field (enable/disable) was not being recalled and 
displayed properly on the form. 
BUG: Deleting an endpoint from a library could produce an object reference error (innocuous) – Fixed. 
FEATURE: Added support for deployment of timer-based maps to trigger based on file/directory creation. 
(Feature copied form v2018 into v2017) 
 
Base.Service 
BUG: DynamicsAXTableClass was referring to mlt__GetSysDataBaseLogFieldChanges in the dbo 
schema rather than the Connectelligence schema – Fixed. 
 
Base.Common 
CHANGE/FEATURE: Throwing an IntegrationError now automatically uses the InnerException where 
available. 
BUG/FEATURE: Better support for bit and uniqueidentifier fields in the ParmsToText() function (Dynamic 
Sql class) 
 
Base.Maps 
FEATURE: Archiver class now allows moving files to date-based folder storage without requiring 
compression. 
CHANGE: Archiver class no longer appends "Archiving existing source file …" on files that it archives, 
making it easier to re-process failed files. 
 
riteTIME Adapter 
FEATURE: Added support for new configuration options: UnpaidBreakRemovalMethod, UserId, 
Password. 



 
Connectelligence 
Version = 2017.12.41 
Release Notes 

Designer 
BUG: Using fully qualified domain names in landscapes was not supported – Fixed. 
FEATURE: Improved support for complex SQL commands minimizing situations where a database view is 
required. 
 
Transaction Manager 
BUG: Maps deployed as batch maps with no service option were showing as disabled – Fixed. 
 
Services 
BUG: Automated logging of transactions containing errors could fail to log the error message – Fixed. 
 
Connectelligence 
Version = 2017.12.40 
Release Notes 

Designer 
BUG: Deleting a file library produced an error (innocuous) -Fixed. 
BUG: Updating a delimited file library path did not update the new path for the DefaultPath in code – 
Fixed. 
BUG: Compiling a delimited file library would log a bogus warning about failing to create an interface – 
Fixed. 
 
Connectelligence 
Version = 2017.12.39 
Release Notes 

Designer 
BUG: Unoptimized maps would fail to compile for deployment – Fixed. 
Designer 
BUG: Added accommodation for custom view creation when dealing with database that have no tables or 
no views. 
FEATURE: Added support for synonyms in custom view creation. 
 
Transaction Manager 
BUG: On some systems an error on startup would prevent the services from loading (refresh solved the 
issue) – Fixed. 
 
Connectelligence 
Version = 2017.12.38 
Release Notes 

Designer 
BUG: A warning intended only for maps targeting functions would appear when attempting to delete any 
map (innocuous) – Fixed. 
BUG: Renaming a map produces a warning that the function is already mapped (innocuous) – Fixed. 
FEATURE: Synonyms now show up as selectable objects when creating a new table-view. 
FEATURE: It is now possible to delete an endpoint map or data map directly from the master data grid. 
FEATURE: Doing a copy (Save-As) of a data map now allows maps that target a function to specify a new 
target function (to avoid a best practices violation) 
FEATURE: Added new Best practice to ensure that functions are targeted by only one data map. 



FEATURE: The endpoint map chooser form now allows hiding of target function endpoints that already 
have mappings. 
 
Connectelligence 
Version = 2017.12.37 
Release Notes 

Designer 
BUG: Default adapter had invalid directory locations which caused it to load with errors – Fixed. 
CHANGE: No messages found in the language tables now provides a warning rather than an error in the 
log file. 
 
Connectelligence 
Version = 2017.12.36 
Release Notes 

Transaction Manager 
BUG: An error message couple appear on startup ‘ImageSource’ already belongs to this DataTable 
(innocuous) – Fixed. 
 
Deisgner 
BUG: Renaming a system map would fail to create a CurrentSystem value in the system maps table (for 
Current Configuration usage) with the new system name.  It also failed to update references to any 
databases in the system that were being used by table/view libraries – Fixed. 
BUG: When deploying a map, and error could be logged (non-interactively) with regard to a duplicate 
mlt_Id field (innocuous) – Fixed. 
FEATURE: Better tolerance for failed library compilations when attempting to map to a new function that 
does not yet exist as a defined endpoint. 
 
Connectelligence 
Version = 2017.12.35 
Release Notes 

Designer 
BUG: Service reference was not always being added to deployed projects under certain conditions – fixed. 
BUG: Args.Log() (Injected command) did not work with tables with identity columns – Fixed. 
CHANGE: Automated clipboard copy functionality removed from base methods. 
 
Connectelligence 
Version = 2017.12.34 
Release Notes 

Designer 
BUG: When changing a namespace in the master data editor, the new namespace was not used in initial 
export types evaluation – Fixed. 
BUG: Source table libraries specifying ORDER BY fields that used a table prefix resulted in errors during 
deployment – Fixed. 
CHANGE: Using quoted identifiers or extended properties in connection strings now causes a warning 
message due to the lack of support for these items in various areas. 
 
Transaction Manager 
BUG: Services grid record colors were not being updated with changes to service status – Fixed. 
BUG: Changes made to the source connection string during a redeployment were not being used in 
operations due to caching of the old value. – Fixed. 



FEATURE: Tools->Database Maintenance->Generate Batch Start/Stop Scripts – creates NET START and 
NET STOP commands for all deployed service maps, for use in mass start/stop operations.  
 
Connectelligence 
Version = 2017.12.33 
Release Notes 

Designer 
BUG: Renaming a table or file library element could fail if there was no transaction table associated with 
the element – Fixed. 
 
Built-In Services 
BUG: Bulit-in service libraries could fail to compile because of an outdated reference to the 
System.ServiceProcess dll – Fixed. 
 
All Services 
FEATURE: Added support for Email SSL/TLS, and PORT specification. 
 
Connectelligence 
Version = 2017.12.32 
Release Notes 

Designer 
FEATURE: Added support for Email SSL/TLS, and PORT specification. 
 
Installer 
BUG: Checkbox to backup prior to update was checked by default even if no previous installation was 
present – Fixed. 
 
Connectelligence 
Version = 2017.12.31 
Release Notes 

Designer 
BUG: When creating a new data map and using a function that does not have endpoints defined and the 
function library fails to compile this results in an infinite loop of error messages – Fixed. 
BUG: Cannot delete data maps from master data tab – Fixed. 
BUG: Attaching a library is broken (all three types) – Not Fixed.  Fixed in v2018. 
BUG: Changing a view definition needs to trigger a background compile – Fixed. 
BUG: Big Brother default max current log file size was set to zero – Fixed. 
BUG: Deleting a map record could cause the entire map to be deleted under certain conditions – Fixed. 
BUG: Auto-logging of transactions (source data) could fail if a source data field had a space in its name – 
Fixed. 
BUG: When deploying or re-deploying, tracked fields were not being added to the tracking table under 
certain conditions – Fixed. 
FEATURE: Holding the shift key while choosing File-Backup now creates a backup copy of your 
configuration in the MLT cloud. 
FEATURE: Added deployment support for .NET v4.6.1, v4.6.2, v4.7 
FEATURE: Warning added if attempting to map to a target endpoint that is already mapped by a data 
map. 
 
Transaction Manager 
BUG: Some service searches could fail to return results if the service map had spaces in its name – Fixed. 
BUG: Deleting (un-deploying) groups of services would fail with a casting error – Fixed. 



FEATURE: Added feature to purge all transaction index records (Tools-Database-Purge transaction tables). 
FEATURE: Added feature to purge all error records (Reports-All-Purge error records) 
 
Installer 
BUG: Install files were being placed in C:\Connectelligence2018 rather than C:\Connectelligence2017 – 
Fixed. 
 
TCPIP Watcher 
CHANGE: User responses to prompts are now logged. 
 
Connectelligence 
Version = 2017.5.16 
Release Notes 

Designer 
BUG: Auto-Logging fails for source field names with spaces in them – Fixed. 
 
Connectelligence 
Version = 2017.5.15 
Release Notes 

Designer 
BUG: Visual Studio Keywords used as field names in data maps caused errors when compiling – Fixed. 
BUG: Null values could cause transaction logging to fail – Fixed. 
 
Connectelligence 
Version = 2017.5.5 
Release Notes 

Designer 
BUG: Error on saving a data map InvalidSourceLibraryTypeException if it had a timer for a source endpoint 
(Innocuous) – Fixed. 
BUG: Deploying from the data maps tab would prompt to recompile if the main library compile was current 
(innocuous) – Fixed. 
BUG: When adding records to a system map an Object reference error would occur after the second save – 
Fixed. 
BUG: When adding records to a system map the automatic background compile (if enabled) could issue two 
compiles in a row, leading to thread-access problems and additional compile time – Fixed. 

 
Connectelligence 
Version = 2017.5.4 
Release Notes 

Transaction Manager 
BUG: Errors could be logged during grid refresh under certain conditions and could prevent the service 
status from updating in the service filter grid – Fixed. 
BUG: Errors logged due to object reference error in function FieldsToShowChanged() – Fixed. 
 
MSMQ 
BUG: MSMQ AddPermissions() calls could be performed and logged redundantly, slowing down 
operations – Fixed. 
 
Connectelligence 
Version = 2017.5.2 



Release Notes 

Designer 
BUG: Upgrading from v2016 could cause the database specification in the config file to get renamed as 
Connectelligence2017 – Fixed. 
 
Connectelligence 
Version = 2017.4.30 
Release Notes 

Designer 
BUG: Could get an error pertaining to GetValueFromCurrentSystem if the database name was something 
other than Connectelligence2017 – Fixed. 
BUG: Data map transformations that relied on the default value (field used in the mapping) rather than named 
parameters could yield null – Fixed. 
BUG: Built-in function Date_Today yielded a null result – Fixed. 
BUG: Project conversion would fail to add required references to Visual Studio project files – Fixed. 
FEATURE: New processing option in each service master table: "Finish All Events Before Continuing".  
(True/False/Empty=Use Default) Checks for new transactions after each transaction run and prior to the timer 
elapsing. 
 
Transaction Manager 
BUG: When selecting a deployed map in the service filter, the map could fail to become the ‘current map’ 
under certain conditions – Fixed. 

 
Connectelligence 
Version = 2017.4.28 
Release Notes 

Designer 
BUG: Recompile failure would give success message when completed. – Fixed. 
BUG: Bouncing between saving changes and rebuilding the library (in the master data editor) could 
eventually wind up corrupting the endpoint (fixed by rebuilding again) – Fixed.  
 
Connectelligence 
Version = 2017.4.26 
Release Notes 

Designer 
BUG: When deploying a map that has not been previously deployed, configuration lookup errors could 
occur – Fixed. 
 
Connectelligence 
Version = 2017.4.25 
Release Notes 

All Services 
FEATURE: Support for authentication added to service email sending. 
 
Designer 
CHANGE: The Big Brother service is now created with startup type = Automatic. 
CHANGE: If an attempt is made to recompile the main library and it is already current (not stale) then the 
user is now prompted to perform the recompile or abort. 
FEATURE: When adding or removing fields from a Table/View library in the master data editor (either by 
changing and then saving or by rebuilding) the associated data map transaction is now updated. 
FEATURE: New option to validate sql on save to check for reserved words in use as field names. 



 
Transaction Manager 
BUG: Choosing to reprocess the previous record could throw an object reference error if no record was 
selected – Fixed. 
CHANGE: Reprocessing multiple records now shifts focus to the Monitor bar after marking the first record 
(instead of waiting until after the last record). 
 
Installer 
BUG: Installer could fail if the Connectelligence2017 directory did not already exist (bug introduced when 
dynamic log file locations feature was added) – Fixed. 
 
Connectelligence 
Version = 2017.4.21 
Release Notes 

Designer 
BUG: When exporting a package, an error regarding the ‘Current system name’ could be generated from 
the “Scripting Views” function (innocuous) – Fixed. 
 
Transaction Manager 
BUG: Service filter grid could go ‘blank’ after selecting a service (very sporadic) – Fixed 
FEATURE: Speed improvement to service filter grid. 
 
All Services 
BUG: When debugging, the assemblyInfo file could be deleted and the debugging stopped with an error 
(very sporadic) – Fixed. 
 
Connectelligence 
Version = 2017.4.18 
Release Notes 

Transaction Manager 
BUG: Service status color was not always displayed properly (did not always match the current state of 
the service) – Fixed. 
 
Connectelligence 
Version = 2017.4.16 
Release Notes 

Designer 
BUG: Adding a new system record to an already existing system map could cause an error on save 
regarding a primary key violation (innocuous) – Fixed. 
BUG: Rebuilding or making changes to a library in the master data editor did not mark the main library as 
stale (and enable recompiling) – Fixed. 
BUG: Renaming a data map did not mark the main library as stale (and enable recompiling) – Fixed. 
BUG: Rebuilding a library item in the master data editor did not automatically map newly created 
endpoints (if auto-map function endpoints was enabled) – Fixed. 
CHANGE/FEATURE: Some of the non-modal messaging has been changed to utilize Windows notification 
icons. 
 
Transaction Manager 
FEATURE: Status field added to list of files to show/hide in Service Filter. 
 
Connectelligence 



Version = 2017.4.12 
Release Notes 

Designer 
BUG: Transactions did not accommodate Sql Server custom data types – Fixed. 
 
Connectelligence 
Version = 2017.4.11 
Release Notes 

Designer 
BUG: Code injection for VB could create Args.Log(ex) in catch block twice – Fixed. 
BUG: Create support case functionality was broken.  File upload was working, but the final email send was 
not – Fixed. 
FEATURE: New option ‘Backup prior to installing updates’ (True by default) 
 
Installer 
FEATURE: Now takes a backup of the current configuration prior to upgrading if ‘Backup prior to installing 
updates’ is true. 
 
Service Report Manager 
BUG: Sql versus File report indicator was not working – Fixed. 
BUG: Changes to existing reports was not saving – Fixed. 
BUG: v_ReportAssocications view was not being created (which was causing errors in the Transaction 
Manager as well) – Fixed. 
BUG: Help button was not linked to help content – Fixed. 
 
Connectelligence 
Version = 2017.4.7 
Release Notes 

Designer 
BUG: Undeploy-redeploy removes service from transaction manager but does not add it back – Fixed. 
CHANGE: No more modal dialog at the end of a successful deployment. 
BUG: Importing a package did not create transaction definitions or maintain transaction tables – Fixed. 
FEATURE: File->Backup/Restore->View Backups.  Provides access to all backup packages for viewing the 
packages or package contents. 
FEATURE: Configurations tab now has a View Configurations option to view all configurations in one form. 
 
Connectelligence 
Version = 2017.4.5 
Release Notes 

Designer 
BUG: The mlt_Id identity column is automatically added to a table being monitored if it does not exist.  
This was true before when the map is deployed for the first time.  Now it is true even if a map was already 
deployed against the table.  (Supports error-free upgrading from older versions). 
BUG: Master data editor – converting a sql command to a view did not save changes to select from the 
view instead of the original command – Fixed. 
BUG: Master data editor – converting a sql command to a view did not accommodate ORDER BY clauses, 
which are not allowed with Sql Server views – Fixed. 
BUG: Undeploy&Redeploy button was not communicating with the Transaction Manager to let it know 
that the map was redeployed (requiring a refresh in the Transaction Manager) – Fixed. 
CHANGE: When editing a database connection containing a password, the password is now revealed if an 
attempt is made to edit the connection string. 



 
Transaction Manager 
BUG: Creating an instance from scratch (with no map) resulted in an object reference error – Fixed. 
BUG: ‘Show search tools’ (Transaction Bar) did not always toggle the search tool controls – Fixed. 
FEATURE: Search tools toolbar now appears on Triggers tab when it is toggled. 
 
Services 
BUG: Services were not honoring stop commands during transactions after encountering warnings – 
Fixed. 
 
Connectelligence 
Version = 2017.4.2 
Release Notes 

Installer 
BUG: The installer could close down services if their name started with Connectelligence – Fixed. 
 
Designer 
BUG: Object reference error could occur when loading libraries under certain conditions – Fixed. 
FEATURE: Added trap for invalid source endpoint definition and included remediation steps in the error 
message (avoids an object reference error when a source endpoint is corrupted or needs rebuilding.). 
 
Connectelligence 
Version = 2017.4.1 
Release Notes 

Designer & Transaction Manager 
CHANGE: Attempting to close the application during a download (downloading an update) now produces 
a warning that a download is in progress before closing the application. 
CHANGE: Upgrading now converts references in config file that refer to Connectelligence2016 to 
Connectelligence2017. 
FEATURE: Log files and Rollback files location can now be configured in the Tools->Options->General-
>Logging.  These directories are transaction and can get very large.  Being able to specify a separate 
location for these means that the root Connectelligence folder can be backed up without containing 
transactional information. 
 
Designer – Consistency check 
Many bug fixes, additional check to validate all file paths for master data libraries. 
 
Deisgner 
BUG: Mass re-deploy could show a modal message after each map deployment – Fixed. 
 
Transaction Manager 
BUG: Clicking on the real-time ribbon now properly limits the service filter to just those maps deployed as 
real-time integrations.  Clicking on the On-Demand ribbon now properly limits the service filter to just 
those maps deployed as on-demand integrations. 
 
Connectelligence 
Version = 2017.3.32 
Release Notes 

Designer 
BUG: Transaction Recreate button was not enforcing required fields (mlt_FkId, mlt_ErrorMessage) – 
Fixed. 



BUG: Promoting a single data map failed if the source or target endpoint was a built-in function or 
adapter – Fixed. 
BUG: Renaming a data map from the data maps tab did not rename the associated transaction (if one 
exists) – Fixed. 
BUG: Current system could fail to resolve under certain conditions with spaces in the name – Fixed. 
FEATURE: Improvements to methodology for fixing corrupted cmap files (consistency check). 
FEATURE: Consistency check now deletes cmap files that reference invalid maps. 
FEATURE: Consistency report now validates all master data paths. 
 
Transaction Manager 
BUG: Resetting all records as processed for a Table Watcher could fail if the source definition had an 
ORDER BY clause – Fixed. 
 
riteTIME Adapter 
BUG: Employee options GUID was getting ’Primary User’ if no user was specified – Fixed. 
 
Connectelligence 
Version = 2017.3.31 
Release Notes 

Designer 
BUG: Code injection – VB.NET generated code could fail to insert Try statement - Fixed. 
BUG: Built-In functions were installing with improper namespace and file settings in master data – Fixed. 
CHANGE: Visual changes to the custom view creation screen for consistency. 
FEATURE: If a newly created data map has transformations, then Enable Transformations is True by 
default the first time the map is used to test or apply. 
FEATURE: New option to script database views on backup. 
 
riteTIME Adapter 
BUG: Specifying an employee options string when creating a new employee ignored the string – Fixed. 
 
Connectelligence 
Version = 2017.3.23 
Release Notes 

Designer 
BUG: Code injection - C# generated code had improper casing, causing compile errors – Fixed. 
BUG: When testing a data map’s function parameters (individual parameter test), no transformation was 
applied if the map was never deployed with ‘Enable Transformations’ – Fixed. 
BUG: Built-in Functions library code file path was incorrect, causing xml help tips to fail to show in the 
transformation popup window – Fixed. 
BUG: Transformations were not allowing saves from popup window if parameter check failed (this check 
is expected to fail for parameters that are not expecting source field names) – Fixed. 
BUG: Built-In Function Database_RunSPROCReturnString was not implemented – Fixed. 
BUG: Some integration flags (such as Enable Transformations) were not being set when choosing a quick-
preview or quick-integrate – Fixed. 
BUG: ParmsToText() function for logging sql commands and parameters was erroring if the sql command 
did not have any parameters – Fixed. 
BUG: Downloading an adapter or other package from the internet was broken – Fixed. 
BUG: Error in current system lookup library could cause system-based database lookup calls to fail under 
certain conditions– Fixed. 
FEATURE: When testing maps with filters, there is no longer a need to select the number of records to 
return as ‘Unlimited records’ - the base code has been optimized to accommodate the filter with any 
number of return records set. 



FEATURE: Import screen now allows the files section (grid) to scroll and enlarge to accommodate a larger 
selection of packages and backup files to be viewed. 
FEATURE: Added abort-retry-ignore loops around export and import routines for scripting or importing 
database views. 
FEATURE: Documentation updates. 
CHANGE: Best practices are no longer enforced on a package import.  Best practices are now enforce on 
an Adapter Export. 
 
Connectelligence 
Version = 2017.3.20 
Release Notes 

Directory Watcher 
BUG: Parsing text fields that contains commas failed – Fixed. 
 
Designer 
BUG: When creating a new endpoint library from the Endpoint Map chooser, the “Create New Library” 
button was not working – Fixed. 
BUG: When creating a new endpoint library from the Endpoint Map chooser, the “Choose” button was 
not working – Fixed. 
BUG: Renaming a data map from the deployment tab would cause errors – Fixed. 
BUG: Remoting timeout could occur when redeploying a map under very specific conditions – Fixed. 
BUG: Validate target fields (from data map) did not work for built-in function targets – Fixed. 
BUG: When deploying and no service credentials are defined, the options form displayed was not 
navigating to the service credentials area – Fixed. 
BUG: When adding, or removing endpoints in the master data editor, summary message of changed 
endpoints was sometimes incorrect – Fixed. 
CHANGE: When adding, or removing endpoints in the master data editor, affected maps with a function 
endpoint are now automatically updated with the endpoint mapping changes if 
AutoMapFunctionEndpoints = True. 
CHANGE: If selecting the menu option to inject code while working with a map that does not support code 
injection, a message is now displayed stating why the inject did not occur. 
CHANGE: Null endpoint is now hidden from available selection (legacy). 
CHANGE: “Enable Workflow” and ”Enable Transformations” options are now hidden when deploying an 
optimized map (these options do not apply to optimized maps). 
 
Connectelligence 
Version = 2017.3.16 
Release Notes 

Phase-1 Landscape changes – incorporating landscapes into master data records. 
1. All installations now get a default landscape (named DEFAULT) created at startup.  Existing items 

that now require a landscape (connections, configurations) are automatically associated with this 
landscape. 

2. Master Data: Added uniqueness constraint on Group, Type, Name. 
3. Endpoint Maps: added uniqueness constraint on Group, Parent, Table. 
4. Creating a new database connection now requires selecting a valid landscape. 
5. Creating a new configuration connection now requires selecting a valid landscape. 

 
Services & Designer 
FEATURE: (Previous feature that was added to Table-Join watcher maps is now added to Table Watcher 
maps) -  Added support for setting database options associated with a view (in a view library).  Database 
settings can be set at the level of the view, view library, or globally. 
 



Designer 
BUG: An ‘No current item’ error could be thrown when navigating to an endpoint in the master data 
editor – Fixed. 
BUG: Error if deleting a configuration or system where no records exist – Fixed. 
BUG: Working with files in delimited libraries that contained spaces could cause errors under certain 
conditions – Fixed. 
BUG: Visual Studio could fail to open in some areas (VS2017 compatibility issue) – Fixed. 
BUG: Upgrading the current project would fail with a “key has already been added’” error – Fixed. 
FEATURE: With best practice enforcement turned on, new table/view library creation now forces the use 
of a connection from a system-configuration and disallows specifying a direct connection. 
FEATURE: Dramatically improved speed of creating new master data and saving after deleting master data 
records. 
FEATURE: Improved refresh speed on all grids. 
 
Directory Watcher 
FEATURE: Accommodation for quoted fields that also can contain the field delimiter. 
 
Connectelligence 
Version = 2017.3.14 
Release Notes 

Services & Designer 
FEATURE: Added support for setting database options associated with a view (in a view library).  Database 
settings can be set at the level of the view, view library, or globally. 
 
Connectelligence 
Version = 2017.3.13 
Release Notes 

All 
CHANGE: Calls to notepad are all replace with calls to the default text file view and only use notepad as a 
failover. 
 
Designer 
BUG: Testing an integration and using a Filter did not save or apply the filter – Fixed. 
FEATURE: Illegal token values are now automatically renamed unless the new name conflicts with an 
existing value. 
 
Transaction Manger 
BUG: Choosing a service-specific report could fail to launch the report – Fixed. 
BUG: Service Report Manager was not enabling the save button after making changes to some fields – 
Fixed. 
CHANGE: Added Report Manager to the Reports-Service menu. 
 
Connectelligence 
Version = 2017.3.12 
Release Notes 

All 
FEATURE: Added support for Visual Studio 2017. 
 
Designer 
BUG: Testing a map or running a map that was not optimized would cause failures if the Args.Log() 
command was used – Fixed. 



 
Install 
FEATURE: Running install will now create any missing database objects in the main and default database 
as well as create the databases if they do not exist (previously only the Install option did this.  Now this 
takes place for the Upgrade option as well). 
 
Connectelligence 
Version = 2017.3.11 
Release Notes 

Designer 
BUG: Compilation of main library would fail if no transactions were defined – Fixed. 
 
Install 
FEATURE: Improvements to upgrade from major version change. 
 
Connectelligence 
Version = 2017.3.9 
Release Notes 

License Manager 
BUG: Manually assigning a license id in the UI could result in errors and key refusal – Fixed. 
 
Designer 
BUG: Project conversion was not updating all references to old paths in VS project files – Fixed. 
 
Installer 
FEATURE: Project conversion from a previous version after a major version change now runs 
automatically, with no pre or post upgrade tasks required by the user. 
 
Connectelligence 
Version = 2017.3.2 
Release Notes 

Designer 
BUG: When deleting an endpoint from the master data tab, the warning message had grammatical errors 
as well as a reference to the current data map (rather than the selected endpoint map) – Fixed. 
BUG: Change report – clicking on Data Map Header produced and error – Fixed. 
FEATURE: Downloading an update now has a progress bar and a cancel button. 
FEATURE: Code injection of parameters now works for C# solutions. 
FEATURE: When using a database enumeration for a system and a related configuration has an invalid 
database specified, only one error is produced, and all other database enumeration lookups are aborted 
until refresh, saving the user from having to wait through multiple database timeouts. 
CHANGE: Code injection of parameter args now uses the name ‘Args’ rather than ‘Args’ plus the map 
name. 
 
Transaction Manager 
FEATURE: Added report for Error Log (all maps) to Reports-All. 
FEATURE: Added report for Error Log (current map) to Reports-Current. 
FEATURE: When performing a global search (Dashboard bar) if no matching records are found a message 
is displayed (rather than just no results). 
 
Reporting 



FEATURE: Improved speed of showing reports.  (Affects most reports that are displayed in separate 
window). 
 
Connectelligence 
Version = 2017.2.31 
Release Notes 
Transaction Manager 

Designer 
FEATURE: Improvements to deploying table watcher maps.  Auto-correcting of mapped field values to 
properly determine the key field name and value. 
 
Installer 
BUG: A clean install would provide an erroneous value for the default database connection string – Fixed. 
BUG: When upgrading, if the database connection failed, the button to change it was disabled – Fixed. 
 
Connectelligence 
Version = 2017.2.24 
Release Notes 

Designer 
BUG: If the default landscape was used the main library would not compile – Fixed. 
 
Transaction Manager 
BUG: Selecting a service could error when attempting to add the menu item for the transactions table – 
Fixed. 
 
Maps Library 
FEATURE: New option to archive file uncompressed with the date-time included in the file name. 
 
Connectelligence 
Version = 2017.2.23 
Release Notes 

Designer 
BUG: Extraneous web service references in the Designer config file were removed. 
FEATURE: New option to warn on deploy if a map is not optimized.  True by default. 
FEATURE: If no landscapes are defined, then you are prompted to name the current landscape. 
FEATURE: Changes Report now includes a tab for all changes in reverse date-time order.  Title also shows 
the date-time of the most recent change made. 
FEATURE: New Code Injection section of options, with options to inject code into new user functions: try-
catch block, mapped fields argument, transaction logging (success and failure). 
CHANGE: Change Control form is now renamed to Changes Report and moved from the tools menu to the 
Reports menu. 
 
License Manager 
BUG: Non-branded version of the License Manager was being packaged with branded builds – Fixed. 
 
Dynamic Sql Library 
CHANGE: Sql parameters are now a local, non-shared property. 
 
Connectelligence 
Version = 2017.2.22 
Release Notes 



All 
Deprecated language messages. 
 
Designer 
BUG: When removing an endpoint in the master data editor, the message improperly referred to added 
endpoints – Fixed. 
BUG: Occasional errors related to the combo box when deleting a system or configuration map – Fixed. 
BUG: Auto-map function endpoints option was not working – Fixed. 
BUG: Transaction auto-logging is not code-injecting after save – Fixed. 
BUG: Data maps with spaces in their name would cause transaction logging to error – Fixed. 
FEATURE: Renaming a data map would only rename arguments in code if they were in the primary code 
file.  Now renaming is done in any code file in the target function project. 
FEATURE: Improved default naming of views when creating a new view from a sql command. 
FEATURE: When importing an adapter, Connectelligence connections in the master data are now changed 
to reference the current Connectelligence connection string. 
 
Transaction Manager 
BUG: Error details on Transactions bar were not wrapping – Fixed. 
BUG: Clicking on a service would give an error stating that ‘Locked’ column is not present.  Recreating the 
v_ReportAssociations view solved the problem – Fixed. 
 
Base Library 
BUG: SQLServer library RunSQL() method did not support using parameters for deadlocks with deadlock 
auto retry = true – Fixed. 
CHANGE: Logging on Sql Retry failover blocks changed to be more general and to include the sql 
command on the first failure (instead of just the last failure). 
 
riteLINK 
FEATURE: Added support for PieceRate field in InsertOrUpdateLevelListValue method. 
 
Connectelligence 
Version = 2017.2.14 
Release Notes 

Designer 
FEATURE: Renaming a data map would only rename arguments in code if they were in the primary code 
file.  Now renaming is done in any code file in the target function project. 
FEATURE: The top position of the main ribbon was off on some systems.  Added a feature Tools->Options-
>User Interface to control this position so that it can be adjusted as necessary on some systems. 
FEATURE: Improved startup time. 
 
Table-Join Watcher 
BUG: Table-table maps had a malformed sql command for inserting records – Fixed. 
 
Base Library 
FEATURE: ParmsToSSMS() method added to Dynamic Sql library. 
CHANGE: Services can now be stopped during transactions if they are encountering warnings (previously 
limited to just errors). 
 
Transaction Manager 
BUG: The default color for warnings in the transaction grid was green, changed to gold – Fixed. 
FEATURE: Reprocessing a transaction now decrements the grid row count in the header. 
FEATURE: Added Select All button to Transactions bar (for reprocessing all records in a grid). 



 
Connectelligence 
Version = 2017.2.12 
Release Notes 

Designer 
BUG: If a field type of object (Timestamp, BLOB, FILSTREAM, etc.) was mapped, the main library would fail 
to compile – Fixed. 
BUG: T_ReportMaster table was not being updated with newly required fields, causing errors when 
deploying maps or working with Transactions – Fixed. 
BUG: Landscape records were not displaying (bug introduced in previous release) – Fixed. 
BUG: Warnings could appear in the log file pertaining to custom images with no path (innocuous) – Fixed. 
BUG: Mass un-deploy from Deployments tab gave an improper warning message prior to un-deployment 
– Fixed. 
BUG: Ribbon control at top of form had a large margin from the top of the form (no code changes, 
perhaps a Visual Studio update caused this?) – Fixed. 
BUG: When performing a mass un-deploy from the data map chooser, no overall progress was shown – 
Fixed. 
BUG: When exporting a promotion and using the RDC repository, the splash message display was 
incorrect – Fixed. 
FEATURE: Verifying target map field usage in functions now support GetParameterByName() usage. 
FEATURE: The machine name is now included in all export packages in the notes field. 
CHANGE: When exporting a promotion and using the RDC repository, if the database update to the 
remote machine fails, the error is suppressed. 
 
Transaction Manager 
BUG: Special transaction types were not showing as colored in the transaction monitoring grid – Fixed. 
 
License Manager 
BUG: Was not clearing existing licenses when importing an encrypted license key (offline licensing) – 
Fixed. 
 
Connectelligence 
Version = 2017.2.10 
Release Notes 

Designer 
BUG: Token names that were not fully qualified (including the system name) were not being recognized – 
Fixed. 
BUG: When changing the name of a library in the master data editor the old name would appear as the 
name after saving (UI only) – Fixed. 
FEATURE: Improved speed of renaming libraries in the master data editor. 
FEATURE: The endpoint map chooser now supports exposing user functions that are not endpoints for the 
source endpoint map chooser (previously supported just for target endpoint maps.) 
FEATURE: Improvements to creating a new endpoint from the Endpoint map chooser including a new 
form for choosing the library to use. 
FEATURE: Improved Xml serializers and de-serializers for data tables and data sets. 
 
Data Access Library 
FEATURE: Reworked support for retrying deadlock errors to apply to more situations 
 
Maps Library 
FEATURE: Archive Class now has an option to archive files without compressing. 
 



Connectelligence 
Version = 2017.2.7 
Release Notes 

Designer 
BUG: Tools->Options password would fail to decrypt properly – Fixed. 
FEATURE: The endpoint map chooser now supports creating new libraries as well as endpoints within 
libraries!  This means that there is no longer a need to define master data prior to creating data maps.  
Master data can be defined as part of the data map creation process. 
FEATURE: Tools->Options now has options for configuring custom colors for grid records in the 
Transaction Manager monitoring grid, and service filter grid. 
FEATURE: Button added to validate map field usage by scanning the target library to determine which 
map fields are not currently in use in the target library. 
FEATURE: Invalid map fields now turn red in the data map sub-tab (red link) as well as the grid sub-tab. 
FEATURE: After making changes to endpoints in the master data editor, it now checks for invalid data 
mappings after save and prompts to remove any invalid endpoints. 
FEATURE: After making changes to endpoints in the master data editor, it now checks for data maps using 
the endpoint and targeting a function, then offers to update those data maps to automatically map the 
new field(s). 
CHANGE: When importing a package, if an icon cannot be overwritten it is no longer logged as an error, 
just as an informational message.  This prevents “errors” from showing at the end of imports due to icon 
files in use. 
CHANGE: When importing a package from the RDC Repository, a warning is displayed if the RDC 
repository folder does not exist. 
 
License Manager 
BUG: When updating a license (Contact Server) and the license key has changed, the license master table 
is now cleared of all records to prevent problems stemming from the existing records with old keys. (User 
is prompted prior to removing license records). 
 
Connectelligence 
Version = 2017.2.2 
Release Notes 

Designer 
FEATURE: Exporting/Importing packages now supports scripting and recreating of any views used by 
libraries. 
 
Transaction Manager 
FEATURE: Log file history report now has files group by date and sorted in descending order. 
FEATURE: Log file buttons are now available on Dashboard tab and transactions tab. 
 
Connectelligence 
Version = 2017.1.32 
Release Notes 

 
NOTE: THIS RELEASE REQUIRES ALL SERVICES TO BE RE-DEPLOYED. 
 
Designer 
BUG: Re-process a selected record would not work under certain conditions and was not using the new 
mlt_Id column – Fixed. 
BUG: When deploying a map that previously had a failed deployment, messages could be logged 
regarding failure to drop database objects (if the db object did not exist) – Fixed. 



CHANGE: The modal message box that displayed (after each success) when performing mass re-
deployment has been suppressed. 
 
Transaction Manager 
BUG: Transactions bar – all grids now show field names if only one service is selected. 
FEATURE: Transactions bar – now shows and sorts by identity column (descending). 
CHANGE: The service monitor is always started when switching to a different service. 
 
Services 
FEATURE: Additional messaging for tracking table update errors. 
FEATURE: Tracking table update now uses the same failover retry sequence as other methods. 
FEATURE: New ParmsToSSMS() method allows for troubleshooting sql command with parameters by 
opening the command and parameter assignments in Sql Server Management Studio. 
FEATURE: Services now support new exception: AbortProcessingSingleTransactionException, when 
thrown, skips the current transaction, processes the backlog, then returns to the skipped transaction. 
FEATURE: Services now support new exception: AbortProcessingAllTransactionsException, when thrown, 
aborts OnTrigger() processing and re-evaluates the trigger. 
 
Connectelligence 
Version = 2017.1.24 
Release Notes 

Designer 
BUG: Unable to set a function as a target endpoint.  Difficulties selecting functions in the master data 
editor – Fixed. 
 
Connectelligence 
Version = 2017.1.21 
Release Notes 

Transaction Manager 
FEATURE: Added new database reports to provide row counts for all tables, database disk space used, Sql 
Server version. 
 
Designer 
FEATURE: When creating a new data map, you now have the option of creating a new function right from 
the Endpoint Map Chooser form.  You no longer have to build your function ahead of time. 
FEATURE: Mass un-deploy and re-deploy of maps added to the Data Map Chooser. 
 
 Connectelligence 
Version = 2017.1.16 
Release Notes 

Designer 
BUG: Refresh button was not visible on Master data tab – Fixed. 
BUG: Rebuilding an endpoint in the master data editor would result in an object reference error 
(innocuous) after rebuild was complete – Fixed. 
BUG: Object conversion errors in Master data editor – Fixed. 
FEATURE: Added library name and library type to Endpoint reports (Endpoints in use, Endpoints not in 
use). 
FEATURE: Service passwords are now encrypted in the database. 
 
Connectelligence 
Version = 2017.1.14 



Release Notes 

License Manager 
BUG: Changing license key would not take effect if licenses were issued under the old key and existed in 
the licensing table – Fixed. 
 
Designer 
BUG: Project conversion from Connectelligence2016 was not updating master data fields referencing 
Connectelligence2016 file paths – Fixed. 
CHANGE: Tracking tables now get a new system field ‘mlt_Id’ which is an identity column.  This field is 
added only if no existing identity column is present.  This is used when reprocessing records. 
FEATURE: Added global timeout settings (affecting Connectelligence (MLTDB) database as well as table-
join-watcher source databases) to Tools->Options. 
FEATURE: Map undeploy now supports mass undeploy of all stale maps (if there are stale maps) or all 
maps (if there are no stale maps) by holding the Ctrl key while choosing to undeploy. 
FEATURE: Map Re-deploy now supports mass re-deploy of all stale maps (if there are stale maps) or all 
maps (if there are no stale maps) by holding the Ctrl key while choosing to Re-deploy. 
FEATURE: Deployments report now sorts by deployment date-time (descending) upon opening. 
FEATURE: Project conversion now has abort-retry-ignore prompts for certain types of failures. 
 
Connectelligence 
Version = 2017.1.5 
Release Notes 

Designer 
Initial 2017 release 


